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GETTING STARTED GUIDE

NI Digital Waveform 
Generator/Analyzer
For NI PXI/PCI-655X/654X Devices

This document explains how to install, configure, test, and set up a National 
Instruments digital waveform generator/analyzer. This document applies 
specifically to the NI PXI/PCI-6551/6552 (NI 655X) and the 
NI PXI/PCI-6541/6542 (NI 654X). For more information on the 
NI 655X/654X, such as features and programming, refer to the NI Digital 
Waveform Generator/Analyzer Help at Start»Programs»
National Instruments»NI-HSDIO»Documentation»NI Digital 
Waveform Generator/Analyzer Help.

Refer to the specifications document that ships with your device for detailed 
specifications.

For free downloads of the most current versions of product documentation 
and example programs, visit ni.com/instruments.
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Conventions
The following conventions are used in this guide: 

<> Angle brackets that contain numbers separated by 
an ellipsis represent a range of values associated 
with a bit or signal name—for example, 
DIO <3..0>.

» The » symbol leads you through nested menu items 
and dialog box options to a final action. The 
sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup 
item, and select Options from the last dialog box.

This icon denotes a tip, which alerts you to advisory 
information.

This icon denotes a note, which alerts you to 
important information.

This icon denotes a caution, which advises you of 
precautions to take to avoid injury, data loss, or a 
system crash. When this symbol is marked on the 
product, refer to the Read Me First: Safety and 
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Radio-Frequency Interference document that 
shipped with your device for precautions to take.

bold Bold text denotes items that you must select or click 
in the software, such as menu items and dialog box 
options. Bold text also denotes parameter names.

CompactPCI CompactPCI refers to the core specification defined 
by the PCI Industrial Computer Manufacturers 
Group (PICMG).

italic Italic text denotes variables, emphasis, or a cross 
reference. This font also denotes text that is a 
placeholder for a word or value that you must 
supply.

monospace Text in this font denotes text or characters that you 
should enter from the keyboard, sections of code, 
programming examples, and syntax examples. This 
font is also used for the proper names of disk drives, 
paths, directories, programs, subprograms, 
subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and 
responses that the computer automatically prints to 
the screen. This font also emphasizes lines of code 
that are different from the other examples.

monospace italic Italic text in this font denotes text that is a 
placeholder for a word or value that you must 
supply.

PCI Peripheral Component Interconnect (PCI) is a 
high-performance expansion bus architecture 
originally developed by Intel to replace ISA 
and EISA.

PXI PCI eXtensions for Instrumentation (PXI) is a 
rugged, open system for modular instrumentation 
based on CompactPCI, with special mechanical, 
electrical, and software features. These features, 
such as the PXI trigger bus, are described in the PXI 
Specification Revision 2.0, which is available from 
ni.com/manuals.
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1. Verifying the System Components
This section specifies the minimum system requirements and recommended 
system for NI-HSDIO and your digital waveform generator/analyzer.

Minimum System Requirements
The minimum system requirements include the following components 
and tools:

• Pentium 200 MHz or equivalent processor

• 64 MB RAM

• A PXI chassis and controller or desktop computer

• 1/8 in. flathead screwdriver

• Number 1 Phillips screwdriver

• Microsoft Internet Explorer 5.5 or later

• Measurement & Automation Explorer (MAX) 3.0.2 or later

• A screen resolution of 800 × 600 with 256 colors (required for the 
NI Script Editor)

• NI SHC68-C68-D2 cable, available from NI

Note Do not use cables other than the NI SHC68-C68-D2 cable 
with the NI 655X/654X.

Recommended System
The recommended system requirements include the following components 
and tools:

• Pentium III/Celeron 600 MHz or equivalent processor

• 256 MB RAM

• A PXI chassis and controller or desktop computer

• 1/8 in. flathead screwdriver

• Number 1 Phillips screwdriver

• Microsoft Internet Explorer 5.5 or later

• MAX 3.0.2 or later

• A screen resolution of 800 × 600 with 256 colors (required for the 
NI Script Editor)

• NI SHC68-C68-D2 cable, available from NI

Note Do not use cables other than the NI SHC68-C68-D2 cable 
with the NI 655X/654X.
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• One of the following digital waveform generator/analyzer accessories:

– NI CB-2162  single-ended digital I/O accessory

– NI SMB-2163 breakout box accessory

• National Instruments SMB cables, available in various styles from 
ni.com

• Windows 2000/NT 4.0 Service Pack 6A/XP 

• One of the following application development environments (ADEs): 

– LabVIEW 7.0 or later (LabVIEW 7.1 or later is required to use the 
NI-HSDIO Express VIs)

– LabWindows™/CVI™ 6.0 or later 

– Microsoft Visual C++ (MSVC) 6.0 or later

Tip When creating your application, consider using other modular 
instruments from the Mixed-Signal Platform, including the 
NI PXI-2593 and SCXI-1193 switches, the NI 5404 clock and 
frequency generator, NI 5421 signal generator, NI 5122 high-speed 
digitizer, NI 4070 digital multimeter, and the NI 6653 Slot 2 
controller.

2. Unpacking
The NI 655X/654X ships in an antistatic package to prevent electrostatic 
discharge (ESD). ESD can damage several components on the device.

Caution Never touch the exposed pins of connectors.

To avoid ESD damage in handling the device, take the following precautions:

• Ground yourself with a grounding strap or by touching a grounded 
object.

• Touch the antistatic package to a metal part of your computer chassis 
before removing the device from the package.

Remove the device from the package and inspect it for loose components or 
any other signs of damage. Notify NI if the device appears damaged in any 
way. Do not install a damaged device in your computer or chassis.

Store the device in the antistatic package when the device is not in use.
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3. Verifying the Kit Contents
Verify that the kit contains the following items:

❑ DVD-sized case, which contains the following items:

– NI-HSDIO (High-Speed Digital I/O) instrument driver software CD, 
which includes the NI Digital Waveform Generator/Analyzer Help

– NI Digital Waveform Generator/Analyzer Getting Started Guide

❑ NI digital waveform generator/analyzer

❑ Mounting screw (PCI device only)

❑ Other documentation included with the digital waveform 
generator/analyzer and driver software. Refer to the Documentation 
section for a list of the documentation you may have.

Documentation
The NI digital waveform generator/analyzer kit may also include the 
following documents:

• NI digital waveform generator/analyzer specifications—This printed 
document provides specifications for your device.

• Read Me First: Safety and Radio-Frequency Interference

• Maintain Forced-Air Cooling Note to Users

• Retrofitting Your PXI Module Note to Users

EMI Gasket (PXI Only)
❑ The NI digital waveform generator/analyzer kit may also include an EMI 

gasket and documentation that describes under what conditions you 
should install the gasket. Refer to step 5. Installing the Hardware for 
information about when you should install the gasket.

4. Installing the Software
This section describes the software installation process for the NI digital 
waveform generator/analyzer.

Choose and Install Your ADE
You can create applications for your digital waveform generator/analyzer 
using LabVIEW 7.0 or later, LabWindows/CVI 6.0 or later, or Microsoft 
Visual C++ 5.0 or later.
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LabVIEW features interactive graphics, a state-of-the-art interface, and a 
powerful graphical programming language. LabWindows/CVI is a complete 
ANSI C ADE that features an interactive user interface, code generation 
tools, and the LabWindows/CVI Data Acquisition and Easy I/O libraries. 
Using LabVIEW or LabWindows/CVI can greatly reduce your application 
development time.

If you have not already installed the ADE, follow the instructions in the 
product documentation to install your ADE now.

Install NI-HSDIO
NI-HSDIO features a set of operations and attributes that allow you to 
programmatically configure and control the digital waveform 
generator/analyzer. To install NI-HSDIO, complete the following steps:

1. Insert the NI-HSDIO CD. The NI-HSDIO installer should open 
automatically. If not, select Start»Run, and enter x:\setup.exe, 
where x is the letter of the CD drive.

2. Follow the instructions in the installation prompts. For troubleshooting 
and operating system-specific instructions, refer to the Hardware 
Installation Wizard at ni.com/support/install.

NI Script Editor
The NI Script Editor is included on the NI-HSDIO CD and is installed when 
you install the driver. The NI Script Editor provides an intuitive interface 
to help you develop linking and looping pattern generation operations.  
NI Script Editor Help contains more information about the NI Script Editor. 
You can access NI Script Editor Help by launching the NI Script Editor and 
selecting Help»NI Script Editor Help from the toolbar.

(Optional) Install the NI Digital Waveform Editor
The NI Digital Waveform Editor (DWE) is included with the higher-memory 
versions of the NI 655X/654X and can also be purchased separately at 
ni.com. The NI DWE allows you to easily import data from popular 
third-party EDA programs, create your own waveforms, edit these 
waveforms, and view acquired waveforms.

If you are using the NI DWE, install it after you install NI-HSDIO.
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5. Installing the Hardware
To install your NI digital waveform generator/analyzer, follow the 
instructions in the section that describes your hardware platform.

When installing your hardware, follow the instructions in this section to 
ensure that your device can cool itself effectively. If the device temperature 
rises above the optimal operating temperature range, the device disables 
itself, and MAX or NI-HSDIO notifies you with an error message.

To re-enable your device after a thermal shutdown, you must perform a hard 
reset, in which the device integrated circuits (ICs) are reloaded. You can 
perform this type of reset either using the niHSDIO Reset Device VI  
(niHSDIO_ResetDevice) or by performing a device reset in MAX. 
The thermal shutdown error is reported until the device is reset. For more 
information on performing a device reset in MAX, refer to 
step 6. Configuring and Testing in MAX.

Installing a PXI Module
To install the module, refer to Figure 1 and complete the following steps:

 

Figure 1.  PXI Installation

1. Power down the chassis before installing the module.

2. If the chassis has multiple fan speed settings, ensure that the fans are set 
to the highest setting. Do not set the fan speed to low or turn the fan off.

NI PXI-1042

PXI Device

Ejector Handle in
Down Position
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3. Position the chassis so that you allow plenty of space between the chassis 
fan intake and exhaust vents. Blocking the fans affects the air flow 
needed for cooling. For more information, refer to the chassis 
documentation.

4. If you need to use an EMI gasket to reduce high-frequency emissions, 
install it now. Refer to the Retrofitting Your PXI Module Note to Users 
for more information about installing the gasket.

5. Remove the packaging material on the PXI connector and on the screws.

6. Ensure that the ejector handle is in the unlatched (downward) position, 
as shown in Figure 1.

7. Holding the module by the ejector handle, slide it into an empty slot, 
ensuring that the base card (on the left when looking at the front of the 
module) engages with the card guides in the chassis.

8. Slide the module completely into the chassis and latch by pulling up on 
the ejector handle.

9. Tighten the captive screws at the top and bottom of the module front 
panel.

10. Before operating the module, install all chassis covers and filler panels. 
Missing filler panels disrupt the necessary air circulation in the chassis.

Note NI recommends that you install slot blockers between 
modules to maximize air flow. NI recommends using the PXI 
Chassis Slot Blocker Kit, part number 778678-01, available for 
purchase at ni.com.

NI PXI modules are sensitive instruments that should be handled carefully. 
Do not expose the module to temperatures or humidity beyond the rated 
maximums. Keep the module free of dust by cleaning with compressed air 
only. Do not clean the module with any solvents or liquids. For more 
information about module cooling, refer to the guidelines in the Maintain 
Forced-Air Cooling Note to Users included with your NI digital waveform 
generator/analyzer.

Installing a PXI Module in a CompactPCI Chassis
The procedure for installing the module in a CompactPCI chassis is the same 
as the procedure for installing the module in a PXI chassis, with the following 
additional considerations:

• The CompactPCI specification (PICMG CompactPCI 2.0 R2.1, 
available from picmg.org) permits vendors to develop sub-buses that 
coexist with the basic PCI interface on the CompactPCI bus. Compatible 
operation of NI PXI modules is not guaranteed between CompactPCI 
devices with different sub-buses nor between CompactPCI devices with 
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sub-buses from different vendors and PXI. The standard implementation 
for CompactPCI does not include these sub-buses.

• The module works in any standard CompactPCI chassis adhering to the 
PICMG CompactPCI 2.0 R2.1 document.

• When you use the NI 655X/654X as a plug-in device in a standard 
CompactPCI chassis, you cannot access PXI-specific functions. 
PXI-specific features are implemented on the J2 connector of the 
CompactPCI bus. The following table lists the J2 pins used by the 
NI 655X/654X. This module is compatible with any CompactPCI chassis 
with a sub-bus that does not drive these lines. Even if the sub-bus is 
capable of driving these lines, the module is still compatible as long as 
those pins on the sub-bus are disabled by default and never enabled.

Maintaining PXI Systems
Clean the fan filters on the chassis regularly to prevent air circulation path 
blockage. Cleaning frequency depends on the amount of use and the 
operating environment. For specific information about cleaning procedures, 
and other recommended maintenance, refer to the module specifications and 
the chassis user documentation.

Table 1.  J2 Pins Used by the NI 655X/654X

PXI Pin Description PXI J2 Pin Number

PXI_TRIG<0..7> PXI trigger lines <0..7>—the eight 
PXI trigger bus lines are highly 
flexible and can be used in a variety 
of ways; for example, triggers can 
synchronize several PXI peripheral 
modules

B16, A16, A17, A18, 
B18, C18, E16, E18

PXI_STAR PXI star trigger line—the PXI star 
trigger bus implements a dedicated 
trigger line between the first 
peripheral slot (adjacent to the 
system controller slot) and the other 
peripheral slots

D17

PXI_CLK10 PXI Clock 10 line—10 MHz PXI 
system clock distributed along the 
PXI backplane

E17
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Uninstalling PXI Modules
When removing PXI modules from the chassis, first power down the chassis. 
Then ensure that you are grounded with a grounding strap or are touching a 
grounded metal surface. To avoid ESD, do not touch the exposed pins of the 
PXI connector or any exposed circuitry on the module. When not in use, PXI 
modules should be stored in the original antistatic packaging to avoid 
damage. 

Caution During operation the metal surfaces of PXI modules may 
become hot. Be careful when removing the module from the chassis 
or when moving it to a different peripheral slot. When removing the 
module, hold it by the ejector handle and front panel only. 

Installing a PCI Device
To install your PCI device, complete the following steps:

1. Power off and unplug the PC.

2. If the PC has multiple fan speed settings, ensure that the fans are set to 
the highest setting.

3. Remove the PC cover.

4. Insert the device into an open PCI slot, as shown in Figure 2.  
NI recommends either leaving the slot adjacent to the fan side of the 
device empty or using lower-profile devices in the slot adjacent to the 
fan side.

5. Secure the device with the screw provided in the kit.

Caution It is important to completely screw the device into the PCI 
slot, both for mechanical stability and for creating a solid ground 
connection, which reduces signal noise. Some computer 
manufacturers use a plastic securing lever to secure PCI devices; 
such a lever is unacceptable and must be removed, or you must use 
a different chassis. Improperly secured devices may affect the 
accuracy of device specifications.

6. Before operating the device, install all filler panels. Missing filler panels 
disrupt the necessary air circulation in the PC.

7. Replace the PC cover.

8. Plug in and power on the PC.
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Figure 2.  PCI Installation

Maintaining PCI Systems
Inspect the onboard fan on a regular basis to prevent fan and air circulation 
path blockage. Cleaning frequency depends on the amount of use and the 
operating environment.

6. Configuring and Testing in MAX
To configure and test the NI digital waveform generator/analyzer in 
Measurement & Automation Explorer (MAX), complete the following steps:

1. Launch MAX to configure and test the digital waveform 
generator/analyzer. MAX should automatically detect the device you 
installed.

2. Expand Devices and Interfaces.

3. Expand NI-DAQmx Devices.

4. Check that your device appears under NI-DAQmx Devices.

1 NI PCI Device 2 PCI Slot 3 Personal Computer

1

2

3
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Note If your device does not appear under NI-DAQmx Devices, 
MAX did not detect the device, so you might need to refresh MAX 
by selecting File»Refresh from the MAX menu or pressing <F5>.

5. You can perform a self-test on devices listed under NI-DAQmx Devices. 
The self-test ensures that the device is installed correctly and can 
communicate with NI-HSDIO. To perform a self-test, complete the 
following steps:

a. Right-click the device you want to test and select Self-Test, shown 
in Figure 3.

Figure 3.  Configuration Tree Shortcut Menu

b. When the self-test finishes, a message window appears to indicate if 
an error occurred. If an error occurred, refer to ni.com/support 
for troubleshooting information.

Tip If you need to reset the device with a hard reset, you can do so 
by right-clicking the device and selecting Reset Device from the 
shortcut menu shown in Figure 3.

6. Record the device name assigned to the digital device. You need this 
information when you program the device.
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Using the Test Panel to Generate and Acquire Data
To verify your device configuration, use the device test panel in MAX to 
generate and acquire simple digital data using your device by completing the 
following steps:

1. Right-click the device under NI-DAQmx Devices, and select Test Panels 
as shown in Figure 3.

2. Click the Generation tab.

3. Select the Dynamic tab on the side of the pane.

4. Click Select All to select all of your channels. The digital pattern now 
appears in the graph.

5. Enter the frequency in the Clock Frequency control, located on the left 
side of the test panel.

6. Enter values for the generation and acquisition voltages in the controls 
below the Clock Frequency control. You can choose from standard logic 
families or enter High and Low values to create your own custom levels.

7. Choose a fill pattern. The following figure shows the pattern control and 
the first few signals in the window.

Tip When generating a Marching Ones or Marching Zeroes 
waveform, it is convenient to make the waveform size a multiple of 
the number of selected channels.

8. Click Play to generate the pattern shown in the graph on the selected 
channels. The default generation option is Continuous, but you can 
toggle this setting using the control below the graph.

The Play and Stop buttons are shown in the following figure.

Because the data channels on the NI 655X/654X are bidirectional, while 
the data is being continuously generated on all of the channels, as in the 
previous step, you can acquire the data being generated.

Note Refer to the specifications for your device for information on 
the setup and hold times and propagation delays associated with 
generation and acquisition operations. At some frequencies, 
generating and acquiring data on the same channels when no cable 
is attached to the DIGITAL DATA & CONTROL (DDC) connector 
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violates these timing parameters and results in incorrectly sampled 
data. For information on proper signal acquisition, refer to the 
NI Digital Waveform Generator/Analyzer Help.

To acquire the pattern, complete the following steps:

1. Click the Acquisition tab.

2. Click Play. The device acquires the digital data that you generated in the 
previous steps, and the data is displayed on the graph.

3. Click Close when you are finished.

7. Connecting Signals
This section discusses what connections you can make to the device, and how 
to connect signals to the device for performing dynamic acquisition and 
dynamic generation. For device front panel diagrams and connector 
descriptions, refer to Appendix A: Device Front Panels.

Connecting Cables and Accessories
To make connections to the NI 655X/654X front panel SMB jacks, use a 
shielded 50 Ω coaxial cable with an SMB plug end.

Use an NI SHC68-C68-D2 cable for connections to the NI 655X/654X DDC 
connector. The NI SHC68-C68-D2 is designed for single-ended, high-speed 
digital signal transmission. The cable is shielded, with individual 
microcoaxial 50 Ω lines for each signal. 

Note Do not use cables other than the NI SHC68-C68-D2 cable 
with your NI 655X/654X.

NI recommends using the NI CB-2162 single-ended digital I/O accessory to 
access the signals on the 68-pin DDC connector and to terminate the 
DIO channels. The NI CB-2162 also provides a platform for circuit 
prototyping and DUT testing. The NI CB-2162 is specifically designed for 
use with NI digital waveform generator/analyzers. For more information 
about using the NI CB-2162, refer to the NI CB-2162 User Guide.

NI also offers the NI SMB-2163 breakout box for National Instruments 
single-ended digital waveform generator/analyzers. The NI SMB-2163 offers 
coaxial SMB connectors for each channel on the DDC connector, providing 
an easy way to connect to other devices for testing and debugging. For more 
information about using the NI SMB-2163, refer to the NI SMB-2163 User 
Guide.

Figures 4 and 5 show how to connect the NI digital waveform 
generator/analyzer and the NI CB-2162 and NI SMB-2163, respectively, 
using the NI SHC68-C68-D2 cable.
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Figure 4.  Connecting the NI CB-2162 Accessory

Figure 5.  Connecting the NI SMB-2163 Accessory

1 PXI Chassis with NI Digital Waveform 
Generator/Analyzer

2 SHC68-C68-D2 Cable
3 NI CB-2162 Accessory

1 PXI Chassis with NI Digital Waveform 
Generator/Analyzer

2 NI SMB-2163 Accessory
3 SHC68-C68-D2 Cable
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Note If you are creating your own accessory to use with your 
device, you can purchase the mating connector for the VHDCI 
cable from NI (part number 778914-01).

Whether you use NI cables and accessories or design your own, you should 
properly terminate cables to avoid improper measurements due to signal 
reflections, overshoot, and undershoot. Refer to the NI Digital Waveform 
Generator/Analyzer Help for more information about signal termination.

Wiring for Common Measurements
Dynamic generation and dynamic acquisition are two categories of 
applications that you can create for NI digital waveform generator/analyzers. 
This section provides information on the general wiring considerations for 
each type of application. Both examples use the NI CB-2162 for signal 
termination.

Dynamic Generation
When performing dynamic generation, an NI digital waveform 
generator/analyzer generates data through a matched impedance system that 
consists of a 50 Ω output impedance, a 50 Ω cable, and a 50 Ω accessory. 
Figure 6 shows a diagram of such a system, using the NI 655X as an example. 
Depending on the loading of the peripheral device, you may need additional 
parallel termination resistance at the destination for optimal signal quality. 
Refer to the NI Digital Waveform Generator/Analyzer Help for more 
information about signal termination. 

Figure 6.  Dynamic Generation Functional Diagram

NI 655X

NI CB-2162

Peripheral
Device

50     Cable
50    
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Dynamic Acquisition
When performing dynamic acquisition with the NI 655X/654X, the source 
generating the signals needs a matched source impedance as close to 50 Ω as 
possible to minimize signal reflections and maintain optimal signal quality. 
Figure 7 shows a diagram of a dynamic acquisition system using the NI 655X 
as an example.

Note NI-HSDIO allows you to set the NI 655X input impedance to 
10 kΩ or 50 Ω, depending on your application. The NI 654X input 
impedance is fixed at 10 kΩ. Refer to the NI Digital Waveform 
Generator/Analyzer Help for more information about signal 
termination.

 

Figure 7.  Dynamic Acquisition Functional Diagram

NI 655X

NI CB-2162

RS
RT

Peripheral
Device50     Cable
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8. Programming the Digital Waveform 
Generator/Analyzer
You can generate or acquire digital data with the NI digital waveform 
generator/analyzer using NI-HSDIO. You also can run the NI-HSDIO 
examples to demonstrate the functionality of your device.

NI-HSDIO Instrument Driver
The NI-HSDIO API features a set of operations and attributes that exercise 
all the functionality of the device, including configuration, control, and other 
device-specific functions.

Information about programming with NI-HSDIO is available in the 
NI Digital Waveform Generator/Analyzer Help. This online document 
contains hardware information, concepts, a detailed function/VI reference 
for NI-HSDIO, and information specific to your device.

NI-HSDIO Examples
The NI-HSDIO examples demonstrate some of the functionality of the 
NI digital waveform generator/analyzers that you can use or integrate into 
your applications.

For the location of example programs that you can use as a basis for your first 
NI-HSDIO program, refer to Programming»Getting Started with 
NI-HSDIO in the NI Digital Waveform Generator/Analyzer Help.
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Appendix A: Device Front Panels
The NI 655X/654X front panels contain four connectors—three SMB jacks 
(CLK IN, PFI 0, and CLK OUT) and one 68-pin VHDCI connector 
(DIGITAL DATA & CONTROL, or DDC).

Figure 8 shows the NI 6541 front panels and pinout, which are identical to 
those of the NI 6542. The DDC signals are described in Table 3. The SMB 
connectors are described in Table 3. The LEDs are described in 
Tables 4 and 5.

Figure 8.  NI 654X Front Panel Connectors
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Table 1.  NI 654X DDC Connector Pins

Pins
Signal 
Name

Signal 
Type Signal Description

33 DDC CLK
OUT

Control Output terminal for the exported 
Sample clock.

67 STROBE Control Terminal for the external Sample clock 
source which can be used for pattern 
acquisition.

1, 3, 5, 7, 9, 
11, 13, 15, 17, 
19, 21, 23, 25, 
27, 29, 31, 35, 
37, 39, 41, 43, 
45, 47, 49, 51, 
53, 55, 57, 59, 
61, 63, 65

DIO <0..31> Data Bidirectional digital I/O data channels 
0 through 31.

26, 30, 64 PFI <1..3> Control Input terminals to the NI 655X for 
external triggers, or output terminals 
from the NI 655X for events.

2, 4, 6, 10, 12, 
14, 16, 18, 20, 
22, 24, 28, 32, 
34, 36, 38, 40, 
42, 44, 46, 48, 
50, 54, 56, 58, 
62, 66

GND Ground Ground reference for signals.

8, 52, 60 RESERVED N/A These terminals are reserved for future 
use. Do not connect to these pins.
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Figure 9 shows the NI 6551 front panels and pinout, which are identical to 
those of the NI 6552. The DDC signals are described in Table 2. The SMB 
connectors are described in Table 3. The LEDs are described in 
Tables 4 and 5.

Figure 9.  NI 655X Front Panel Connectors
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Table 2.  NI 655X DDC Connector Pins

Pins
Signal 
Name

Signal 
Type Signal Description

33 DDC CLK
OUT

Control Output terminal for the exported 
Sample clock.

67 STROBE Control Terminal for the external Sample clock 
source which can be used for pattern 
acquisition.

13, 15, 17, 19, 
21, 23, 25, 27, 
29, 31, 47, 49, 
51, 53, 55, 57, 
59, 61, 63, 65

DIO <0..19> Data Bidirectional digital I/O data channels 
0 through 19.

26, 30, 64 PFI <1..3> Control Input terminals to the NI 655X for 
external triggers, or output terminals 
from the NI 655X for events.

2, 4, 6, 10, 12, 
14, 16, 18, 20, 
22, 24, 28, 32, 
34, 36, 38, 40, 
42, 44, 46, 48, 
50, 54, 56, 58, 
62, 66

GND Ground Ground reference for signals.

1, 3, 5, 7, 8, 9, 
11, 35, 37, 39, 
41, 43, 45, 52, 
60

RESERVED N/A These terminals are reserved for future 
use. Do not connect to these pins.
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Tables 4 and 5 describe the different conditions indicated by the two 
NI PXI LEDs.

Table 3.  NI 655X SMB Connectors

Connector
Signal 
Name

Signal 
Type Description

CLK IN Reference/
Clock Input

Control Terminal for the external Reference 
clock used for the PLL or for the 
external Sample clock used for 
pattern generation and/or 
acquisition.

PFI 0 Programmable 
Function 
Interface 
(PFI) 0

Control Input terminal to the device for 
external triggers, or output terminal 
from the device for events.

CLK OUT Reference/
Clock Output

Control Terminal for the exported PLL 
Reference clock or the exported 
Sample clock.

Table 4.  ACTIVE LED Indicators

Color Indications

Off Device not armed, not triggered, or experiencing an error.

Amber Device armed and awaiting Start trigger. If performing a 
dynamic acquisition operation, the device may be acquiring 
pretrigger samples.

Green Device received Start trigger.

Red Error condition.

Table 5.  ACCESS LED Indicators

Color Indications

Off Device not ready.

Amber Device being accessed by software.

Green Device ready to be programmed.

Red Running the niHSDIO Self Test VI or calling 
niHSDIO_self_test produced a failure.
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Appendix B: Troubleshooting

Device Front Panel ACCESS LED on PXI Module is Off 
When PXI Chassis is On
If the ACCESS LED is not lit after you power on the PXI chassis, a problem 
may exist with the PXI power rails, a hardware device, or the LED.

Note The LEDs may not light until the device has been configured 
in MAX. Before troubleshooting this issue, verify that the device 
appears in MAX.

Troubleshoot this issue by completing the following steps:

1. Power off your PXI chassis.

2. Disconnect any signals from the PXI module front panel.

3. Remove the PXI module and inspect for signs of damage. Do not reinstall 
a damaged device. 

4. Reinstall the PXI module using the procedure described in 
step 5. Installing the Hardware.

5. Power on your PXI chassis.

6. Verify the device appears in MAX.

7. Reset the device in MAX and perform a self-test. Refer to 
step 6. Configuring and Testing in MAX for information on performing 
device resets and self-tests in MAX.

8. If the ACCESS LED still fails to light, contact NI support at 
ni.com/support.

Device Does Not Appear in MAX
Complete the following steps if the NI device does not appear in MAX:

1. In the MAX Configuration pane, click Devices and Interfaces to expand 
the category.

2. Click NI-DAQmx Devices and press <F5> to refresh the list of installed 
devices.

3. If the device is still not listed, power down the system, ensure the device 
is correctly installed, and restart.

4. If the device still does not appear under NI-DAQmx Devices, contact 
NI support at ni.com/support.



NI Digital Waveform Generator/Analyzer Guide 26 ni.com

Device Failed the Self-Test
The MAX self-test performs a brief test of device resources. If the device 
does not pass the self-test, complete the following steps:

1. Reboot your system.

2. Launch MAX and perform the self-test again. If the device still fails the 
self-test, proceed to step 3.

3. Uninstall and reinstall NI-HSDIO.

4. If the device still fails the self-test, contact NI support at ni.com/
support.

I Received a Thermal Shutdown Error
I received the kErrorDeviceShutDownDueToHighTemp error, and my 
device shut down. What should I do next?

To re-enable your device after thermal shutdown, complete the following 
steps:

1. Power down the computer or chassis that contains the device.

2. Review the procedure in step 5. Installing the Hardware and make any 
necessary adjustments to ensure that your device is effectively cooled.

3. Call niHSDIO_ResetDevice (NI-HSDIO Reset Device VI) or perform 
a device reset in MAX. The thermal shutdown error continues to be 
reported until the device has been successfully reset.

Technical Support Resources

NI Web Support
National Instruments Web support is your first stop for help in solving 
installation, configuration, and application problems and questions. Online 
problem-solving and diagnostic resources include frequently asked 
questions, knowledge bases, product-specific troubleshooting wizards, 
manuals, drivers, software updates, and more. Web support is available 
through the Technical Support section of ni.com.

A Declaration of Conformity (DoC) is our claim of compliance with the 
Council of the European Communities using the manufacturer’s declaration 
of conformity. This system affords the user protection for electronic 
compatibility (EMC) and product safety. You can obtain the DoC for your 
product by visiting ni.com/hardref.nsf. If your product supports 
calibration, you can obtain the calibration certificate for your product at 
ni.com/certification.
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Worldwide Support
National Instruments corporate headquarters is located at 
11500 North Mopac Expressway, Austin, Texas, 78759-3504. 
National Instruments also has offices located around the world to help 
address your support needs. You can access our branch office Web sites from 
the Worldwide Offices section of ni.com. Branch office Web sites provide 
up-to-date contact information, support phone numbers, email addresses, and 
current events.

If you have searched the technical support resources on our Web site and still 
cannot find the answers you need, contact your local office or National 
Instruments corporate. For telephone support in the United States, dial 
512 795 8248. For telephone support outside the United States, contact your 
local branch office: 

Australia 1800 300 800, Austria 43 0 662 45 79 90 0, 
Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599, 
Canada (Calgary) 403 274 9391, Canada (Ottawa) 613 233 5949, 
Canada (Québec) 450 510 3055, Canada (Toronto) 905 785 0085, 
Canada (Vancouver) 604 685 7530, China 86 21 6555 7838, 
Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 
Finland 385 0 9 725 725 11, France 33 0 1 48 14 24 24, 
Germany 49 0 89 741 31 30, India 91 80 51190000, Israel 972 0 3 6393737, 
Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 02 3451 3400, 
Malaysia 603 9131 0918, Mexico 01 800 010 0793, 
Netherlands 31 0 348 433 466, New Zealand 0800 553 322, 
Norway 47 0 66 90 76 60, Poland 48 22 3390150, 
Portugal 351 210 311 210, Russia 7 095 783 68 51, 
Singapore 65 6226 5886, Slovenia 386 3 425 4200, 
South Africa 27 0 11 805 8197, Spain 34 91 640 0085, 
Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51, 
Taiwan 886 2 2528 7227, Thailand 662 992 7519, 
United Kingdom 44 0 1635 523545
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